
Welcome to RealView 3.0 
  

 
  
RealView is a measurement application, which records and plots measured values from several hardware devices.  
  
Several curves can be plotted into a single diagram.  
Several diagrams can be arranged on one or more pages if necessary.  
  
Plot options like pen width, pen color, background color, etc. can be used to create perfectly styled diagrams. You can even create your 
own plotter designs. 
  
Comfortable zoom functions are available on a single click to analyse plot details or to return to the plots overview.  
  
Setting markers makes it easy to read differential values of a plot, or to determine the amplitude or period of a sampled signal.  
  
A comfortable preview allows you to add comments or project data when printing diagrams.  
  
Export functions can be used to use measured data with other applications like MS-Excel, etc.  
 
The following little example describes the basic steps that are necessary for a measurement application with RealView.  
  
For further information and updates, please visit our homepage www.abacom-online.de/uk 
New features of RealView 3.0 
  
Improved CPU-usage - Better performance 
The internal timing and interruptfunctions were completely new designed. This guarantees a better performance and the CPU capacity 
utilization will be significantly lower. 
  
Signal-Smoothing function 
The signal smoothing can be adjusted from very low to extreme for each channel. So you can display e.g. trends, without any 
disturbing noise. The function works similar as a low pass. 
  
Fullscreen-View 
The fullscreen-view displays a plotter on the complete screen, without any disturbing windows, menus, toolbars, etc. The so gained 
usable area of the screen is considerable. 
  
Heartbeat-mode 
This new running mode simulates the well-known method of a heartbeat-monitor. A beam is always running from the left to the right and 
updates the plotter. The advantage of this method is, that no flickering scrolling is necessary. 
  
New displays 
Each channel can now show additional displays. Beside the numeric display there are also a min/max and a tendency display available. 
  
Digits after decimal point 
You can now edit the number of digits after the decimal point for each channel. This increases the clearness, because there are no 
unneeded digits which makes the reading of the values more difficult. 
  
Logging 
You can now log your measurement values during the recording in a special ASCII-file. This file can be used from other applications to 
get access of the measured values even during the recording . 
  
Formula calculation 
Each channel can be calculated by a free formula. You can use almost any general mathematical function like +,-,*,/,sin(),cos(),abs(),int
(),ln(),log(), etc. You can even use the numeric values of the other channels in your formula. 
  
Hardware: User-Interface  
You can use this new hardware device to define a sipmle serial protocol and use it with your own designed hardware. This works not only 
with the serial port, you can even use it with the USB port over the "virtual com" function of many USB devices. 
  
Windows Vista  
RealView is now running under Vista.  
Software registration  
  
You can send us your registration form, to get information about updates and new ABACOM products. To get the registration form please 
select Software registration... from the Registration menu. 
  
Note: 
If you received your software directly from ABACOM, the registration is not necessary. 
  
RealView control elements 
  
Click on the picture to find related help topic... 
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The toolbar 
  
The toolbar offers the main functions that are available for the plotter: 
  

 Setup 
Opens the configuration dialog of the plotter. 
  

 Start 
Starts recording and plotting of incoming values. 
  
Stop 
Stops the recording, when you have finished your measurement. 
  

 Pause 
Stops the recording, but incoming values will still being sampled and recorded. This is useful to view data that has been recorded, while 
the recording process continues. 
  

   Cursor-mode 
Here you can select the cursor-mode. The cursor-mode determines the function of the mouse on the plotter: 
  

l In the zoom-mode you can zoom in and out in your curves.  
l In the measure-mode you can make relative measurements in your curves  
l In the PAN-mode you can move and zoom your curves  

  
  

   Plot mode 
Three plot modes are selectable.  
  

l Use the interpolation mode to connect measured values with straight lines.  
l In the sample and hold mode a value is sampled from the hardware device and then hold until the next value is available. The 

plotted diagram will look like stairs.  
l Use the point mode to plot measured values without any connecting lines.  

Seite 2 von 23Welcome to RealView 3.0

12.10.2011file://C:\Dokumente und Einstellungen\Lot\Lokale Einstellungen\Temp\~hh34EF.htm



  
  

 Follow curve 
While the plotter is stopped or paused, you can use this mode to simplify reading certain values of your plot. With this function activated, 
the mouse cursor (reticule) will stick to the curve. 
  

 Marker 
This buttons activates the marker, which are useful to analyse a plot. The markers lines can be moved to any position in the diagram. You 
can click an the right arrow, to get some special functions for the marker. 
  

 Zoom previous 
Recalls to the previously zoomed position. 
  

 Special zoom functions 
Here you can call some special zoom functions: 
  

 Sets the optimum Y-range for the selected curve. 

 Sets the optimum Y-range for each curve separate. 

 Sets the optimum common Y-Range for all curves. 

 Displays the complete time-range. 
  
  

 X-plus 
Increases the X-magnification, which stretches the curve along the X-axis. 
  

 X-minus 
Decreases the X-magnification. 
  

 Y-plus 
Increases the Y-magnification, which stretches the curve along the Y-axis. 
  

 Y-minus 
Decreases the y-magnification. 
  

 Print 
Opens the print preview dialog. 
  

 Export 
Writes an export file, which can be imported in other applications, like MS-Excel. 
  

 Copy to clipboard 
The diagram is copied as a bitmap to the windows clipboard. Paste the clipboard to other application that can handle bitmaps. 
The channel list 
  
You can add as many channels (curves) to a plot (diagram) as you like. Channels appear in the channel list on the left of each plot 
window. 
  

 
  
On the top of the channel list the actual sampling- and display-rate is displayed. You can edit these values by clicking on it, without 
calling the setup-dialog of the plotter. 
  
Below these values there are 4 buttons: 
  

 Add a new channel 
  

 Delete the selected channel 
  

 Show or hide the numeric, min/max and tendency display. 
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 Here you can determine, if you want several separate Y-axes, ore one common Y-axis for all channels. 
  
  
Below these buttons is the list of all channels. You can select a channel with a simple click on the name. The selected channel will be 
marked with a yellow background color. Many functions are relating on the selected channel, so please select the desired channel before.
  
On the left of each channel is a button with the actual color of the channel. Use this button to call the setup-dialog of the channel. 
  
With the check mark you can show or hide the curve in the display. If it is checked the curve will be displayed, if not the curve will not be 
displayed in the diagram. 
  
Each channel of a plot is equipped with its own Y-range, scale, color, etc. 
  
The width of the channel list is adjustable. Therefore move the cursor to the borderline between channel list and diagram and drag the 
line to another position. 
  
The caption 
  
The name of a plotter (diagram) is displayed in its caption. The captions background appears in dark blue, if the plotter is selected, 
otherwise is appears in gray.  
  
All functions of the plotter control toolbar take effect only on the currently selected plotter. Click to the caption of a plotter to select it.  
  
Some additional information of the plotter can be found on the right of its caption. 
  

 
  
The green display shows the time, when the plotter was started. The red display shows the stop time of the plotter. You also find 
information about the number of samples that have been recorded, and how much memory was used for the recording.  
  
The red LED is a dropout indicator. It will flash whenever values are dropped during the recording. This may appear if the sample rate is 
set too high for an individual hardware device.  
  
Use the close button (x), to close plotters, that are no longer needed.  
The arrow button on the left hides the plotter information, if not needed. 
Hardware configuration 
  
Before starting a measuring, the first thing to do is to let RealView know, which hardware devices are available in your system. RealView 
supports different types of hardware from several manufacturers. A complete list of supported hardware devices can be found in the 
appendix.  
  
Select the Configuration... item from the Hardware menu. 
  

 
  
The hardware dialog shows two lists. The list on the left offers all devices that can be used with RealView. A tree view offers the 
hardware sorted in groups. Click on the (+) button to see the hardware list of a group.  
  
All devices that you want to use have to be added to the list on the right. If you have found a hardware device that you want to use, you 
can drag and drop it from the list on the left to the list on the right. A configuration dialog for the device will appear whenever you add a 
new device to the list on the right. Enter the correct information to the configuration dialog, which is necessary for your individual 
hardware device. Refer to the manual of your hardware device, to learn about the meaning of the configuration dialog.  
  
Use the Setup... button to change the configuration of a hardware device whenever necessary.  
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The Delete button removes the selected device from the list on the right. 
  
  
  
Tip: 
You can save these settings durable, using the project-template. 
Channel configuration 
  
You can add as many channels (curves) to a plot (diagram) as you like.  
The channels appear in the channel list on the left of each plotter. 
  

 
  
  
The colored button on the left of each channel opens the property dialog of the channel. 
  

 
  
The channel configuration dialog offers the following features: 
  
Name  
Enter a name to this field. The channel name will appear in the channel list.  
  
Color  
Click to this button to select the pen color for plotting this channel.  
  
Width  
Adjust the pen width used to plot this channel.  
  
Basic unit  
Enter the basic unit for the values measured with this channel.  
For example only enter V not mV.  
  
Decade  
Select a decade for measured values. Select m for mV values or K for KOhm.  
  
Automatic  
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Check this option to let RealView determine the decade of your values automatically.  
  
Range  
Enter the default range for your plot. Change the range whenever necessary.  
  
Digits 
Here you can define the number of digits after the decimal point. 
If you don't care about this you can select Auto. 
  
Smoothing 
This function is to "smooth" curves. 
The signal smoothing can be adjusted from very low to extreme for each channel. So you can display e.g. trends, without any 
disturbing noise. The function works similar as a low pass. 
  
Offset  
The offset is a constant value that is added (positive) or subtracted (negative) from the measured value.  
  
Factor  
The factor is a constant value that is multiplied with the measured value.  
  
Differential values 
Use this option to calculate and plot the differential values between the current value and the previously measured value.  
  
Source  
This setting is most important and determines which hardware (pin) delivers values for the plotter channel.  
  
Hardware  
Normally a hardware device is used to sample analogue values. Hardware devices offer at least one ore more data channels (pins, 
inputs). Select the Hardware option and click on the Assign... button.  
  

 
  
Select an input channel of the hardware device, which delivers the values for the plot channel. 
  
The list offers all hardware inputs that are available from the devices that are connected to your system. (See also Hardware 
configuration)  
A click to the (+) button of a devices shows all input channels (pins) that are available. Select the correct input channel. Click OK to 
assign the hardware input to the plotter channel. 
  
  
Calculation:  
You can use a formula to calculate the value of a channel (curve). 
Within this formula you can use almost every general mathematical function: 
  

  

+ Addition

- Subtraction

* Multiplication

/ Division

Sin Sine (radiant)

Cos Cosine (radiant)

Abs Absolute

Int Integer

Log Logarithm (basis 10)

Ln Logarithm (basis e)

^ Raise

( ) Parenthesis
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You can even use the values of each other curve you have defined on your plotter. 
Use the wildcards C1,C2...Cn for each available curve in your formula. 
  
E.g. if you are measuring a voltage on C1 and a current on C2, you can calculate the power on Channel 3 by the following formula: 
C1*C2 
  
Enter the formula without equal sign!  
Examples:  
A simple multiplication: C1*C2  
A little more complex: (C1*C2) / 1000+123  
Function's argument in parenthesis: sin(C1/100)  
If an error occurs in calculation, the result is set to zero 
  
  
Tip: 
You can save these settings durable, using the project-template. 
Plotter configuration 
  
Open the plotter configuration dialog with a click on the Setup button of the toolbar or double click to the plotter caption. 
  
The dialog has 3 pages: Settings, Functions and Design. 
  
  
The page "General" 
On this page you edit the general settings for your plotter. 
  

 
  
Title 
Enter a name for the diagram (plotter). The name will appear in the caption of the plotter, and optional in the printout. 
  
Measurement parameters 
  

l Sample rate 
Enter a sample rate that is suitable for your measurement. The plotter will request data from the input device using this rate. 

l Display refresh rate 
Here you can edit how often RealView will update the display while the plotter is running. For a fast floating animation you can 
select small refresh rates. Using longer refresh rates may results in calmer displaying. 

  
Time axis 
  

l Measurement duration 
If you select this option, the time axis will start with 00:00:00 and shows therefore the duration of the measurement. 

l Real time 
If you select this option the time axis will display the real time. 

l Display date 
This feature enables/disables the display of the date. Display of date only makes sense for long-term recordings that last for more 
than one day.  
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Logging 
Activate this function to log all measurement values during the recording in a special ASCII-file. You can determine the folder for this file. 
The values will be loggend in ASCII-format. For example, the file will look like the following if 2 channels are defined: 
  
value1;value2 
value1;value2 
value1;value2 
... 
  
The semicolon is used to separate the values. 
Each new measurement will add a new row to the file (depending on the sample rate). 
The filename is created automatically. It will be the name of the plotter plus the starting date and time. The extension of the file is 
always *.txt. 
  
An example of a logging file is: Plotter 1- 16.04.2008 14-36-19.txt  
  
  
  
The page "Design" 
On this page you can define the look and the colors of the plotter. All changes that you made on this page will be immediately assign to 
the plotter, so you can always see the effect of your changes. 
  

 
  
  
Running mode  
Here you can define the behaviour of the plotter during the recording. 
  

l Scrolling 
If the plotter reaches the right end, it will scroll to the left. You can determine the scroll range procentual. 100% means, that the 
full range will be scrolled, so the new plot begins at the left of the plotter. 
0% means, that only one measurement will be scrolled to the left. This will be done every time, and so it produce a floating 
display. 

l Heartbeat mode 
This running mode simulates the well-known method of a heartbeat-monitor. A beam is always running from the left to the right 
and updates the plotter. The advantage of this method is, that no flickering scrolling is necessary.  

  
Y-grid / Time-grid 
  

l Display grid 
This option enables/disables the drawing of grid lines. 

l Narrow grid 
Check this option to decrease the distance of grid lines. If this option is checked, more grid lines will be displayed. In the Y-axis you 
can select between several grid distances. 

l Colored grid 
Use this option to get a colored grid background. Each second segment of the grid will have another color than the normal 
background. You can define these color with a click on the color-field. The option Top determines, which colored grid is on top if 
the grids are crossing each other. 

Seite 8 von 23Welcome to RealView 3.0

12.10.2011file://C:\Dokumente und Einstellungen\Lot\Lokale Einstellungen\Temp\~hh34EF.htm



  
Colors 
In this section you can define all colors of your plotter. Please note, that especially the background colors will have a good contrast with 
the channel-colors. The best background colors are very light or dark colors. Because the standard colors in windows are not very similar 
with this, it is often useful to define your own colors. 
  
Design 
Every setting on this page can be saved as your own design. You can easily recall your created designs for any other new plotter. A few 
designs are already included after you have installed the software. 
  

l To select a design, just click on the list and pick the design you want from the list. 
l To save a new edited design, just click on the button Save as...  and give your new design a name. 
l To delete an existing design, just select this design from the list and click on the button Delete.  

  
  
  
  
The page "Trigger" 
With the trigger function you can start the plotter automatically, if a measurement value reaches a determined value. If you start the 
plotter, the recording will wait until the determined event will occur. 
  

 
  
Activate trigger mode 
Here you can activate the trigger mode. 
  
Channel 
Here you can determine on which channel you want to trigger. 
  
Threshold value 
Here you can enter the desired trigger value. 
  
Positive/Negative 
If you select Positive, the plotter will start recording, if the measurement value becomes higher than the threshold value. 
If you select Negative, the plotter will start recording, if the measurement value becomes lower than the threshold value. 
  
  
  
The page "Auto start/stop" 
Here you can limit the recording time of the plotter. You can even define automatic saving and restart. With this features you can create 
automatic periodical measurements. 
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Stop plotter automatic after 
Here you can define the recording time for the plotter. 
  
Save plotter automatic in folder 
Here you can define, if the plotter has to be saved after reaching the time limitation. You can select the folder, where to save the file(s). 
The filename will be generated by RealView and it contains the start- and stop-time of the plotter. This will help you to find the desired 
file, even if there are much files in the folder. 
  
Export plotter data automatic in folder 
With this option you can automatically export the recorded values in a ASCII-file. 
You can edit the format with Define export... This function is similar with the manual data export. 
  
Start plotter again 
Here you can define, if the plotter should start again, after he has stopped automatic. 
  
  
  
Tip: 
You can save these settings durable, using the project-template. 
Navigation in curves (zoom and scroll) 
  
After recording a plot, you can zoom and scroll to areas of the plot that are of special interest for you. You can display the whole curve, 
or zoom in the curve to display the areas you want. To make the navigation as simple as possible, RealView offers comfortable zoom- 
and scroll-possibilities. 
  
To scroll in X-direction (time axis) use the scrollbar on the bottom of the plotter. 
  
For zooming you have several possibilities. You can zoom intuitive with the mouse or you can use special zoom functions from the 
toolbar. 
  
  
Zoom-functions from the toolbar 
  

 Special zoom-functions 
Here you can call some special zoom functions: 
  

 Sets the optimum Y-range for the selected curve. 

 Sets the optimum Y-range for each curve separate. 

 Sets the optimum common Y-Range for all curves. 

 Displays the complete time-range. 
  
  

 Zoom previous 
Adjusts the zoom factor to previous values.  
This function can be repeated. RealView remembers all previous zoom positions. 
  

  X-Plus/Minus 
Use these functions to adjust only the X zoom factor.  
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The Y zoom factor will stay unaffected. 
  

  Y-Plus/Minus 
Use these functions to adjust only the Y zoom factor.  
The X zoom factor will stay unaffected. 
  
  
  
Zoom intuitive with the mouse 
  
You can zoom with the mouse directly on the plotter. For that purpose, the cursor-mode has to be the zoom-mode. 
  
  
You have 3 possibilities to zoom with the mouse: 
  

l Left mouse button - zoom in 
Click with the left mouse button to increase the zoom factor. The click position will become the centre of the diagram and the zoom 
factor is increased. 

l Right mouse button - zoom out 
Click with the right mouse button to decrease the zoom factor. 

l Zoom in an area 
Use the mouse to draw a frame of the area that is of special interest for you. Click to the first corner of the area, hold the mouse 
button down, and draw a frame by moving the mouse to the second corner. The new area will be zoomed, when the mouse button 
is released.  

  
  
  
Intuitive scaling the Y-axes with the mouse 
  
You can edit the Y-scaling very easy and comfortable with the mouse. 
  
The cursor-mode 
  
with the cursor-mode you cam determine the function of the mouse within your plotter area. You can select the desired cursor-mode in 
the toolbar. There are 3 different cursor-modes: 
  

 Zoom 
In the zoom-mode you can easily zoom with your mouse. 

  

 Measure 
In the measure-mode you can make relative measurements in your curves. 

  

 PAN 
In the PAN-mode you can move and zoom your curves. 

  
  
  
Zoom-mode 
  
The zoom-mode is the most important cursor-mode. 
In this mode you can zoom easily with your mouse. 
  

l Left mouse button - zoom in 
Click with the left mouse button to increase the zoom factor. The click position will become the centre of the diagram and the zoom 
factor is increased. 

l Right mouse button - zoom out 
Click with the right mouse button to decrease the zoom factor. 

l Zoom in an area 
Use the mouse to draw a frame of the area that is of special interest for you. Click to the first corner of the area, hold the mouse 
button down, and draw a frame by moving the mouse to the second corner. The new area will be zoomed, when the mouse button 
is released. 

  
  
Measure-mode 
  
In the measure-mode you can't change the display of your curves. 
Anyway, this mode is interesting for making measurements on the recorded curves. You can click on any position in your diagram and 
draw the mouse. The relative measurement values will be always displayed.  
  
  
  
PAN-mode 
  
The PAN-mode is an alternative for the zoom-mode.  
You can reach every region of your curve in this mode, too. But the nature of this mode is different: 
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l Left mousebutton click and draw 
You can move the curve in any direction. The curve "sticks" on the mouse. 

l Right mousebutton click and draw 
You can zoom in or out your curves. With vertical mousemoves, you can zoom the Y-axis, with horizontal moves you can zoom the 
time-axis. 

  
  
Comfortable Y-range adjustment 
  
RealView offers a convenient way of range adjustment for each curve. There is no need to enter minimum and maximum values to 
dialogs anymore! 
  

 
  
  
Simply move the mouse cursor to the scale on the left of the curve. The cursor will appear as an up/down arrow. This indicates that you 
can adjust the Y-range: 
  

l With pressed left mousebutton you can move the Y-range  
l With pressed right mousebutton you can scale the Y-range  

  
Just move the mouse vertically while pressing the button, and see what happens. 
  
This technique of range-adjustment is most effective with multi-channel recordings, where several curves have to be placed one below 
the other. Simply select a channel and move it to a suitable position. 
Working with markers 
  
Markers are a useful tool for analysing a segment of a curve. Markers make it easy to read time or value information.  
  
Before activating the markers function, you should zoom to the curve region that has to be analysed. Activate/deactivate the markers 
with the corresponding button of the toolbar. 
  

 
  
Whenever the markers are activated, they will appear at a default screen position. The advantage of that is that you do not have to 
search for them, if markers were placed somewhere else on the curve before.  
  
Markers are displayed with two vertical and two horizontal lines that form a rectangle. The marker and the rectangle will be displayed in 
the color of the selected channel. This indicates immediately for which channel the Y-values are valid. The marker ranges are displayed 
on bottom of the channel-list. 
  

 
  
To adjust the markers, move the mouse cursor to one of the marker lines. The mouse cursor will appear as a double arrow. Hold down 
the mouse button and move the line to another position. The marker display is constantly updated during this operation. 
  
  
  
Additional marker functions 
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RealView offers additional special functions for the marker. 
Click on the arrow on the right of the marker-button, and you will get a menu with the following functions: 
  

 Find  min/max 
This function finds minimum and maximum values in the marker range and sets the y values of the marker to the found 
values. This is very helpful to measure amplitudes, etc. 

  

 Find periode 
This function tries to find a period in the measured signal, starting at the markers left position and set the markers right 
position to the found position. 

  

 Calculate integral 
This function calculates the integral (plane) of the curve within the marker. The area which will be calculated is always 
displaying within the marker. 

  

 Cut time-axis 
With this function you can cut your complete measurement to the time-range of the marker. All measurement values outside 
the marker will be lost. 

  
  
Note: 
Remind that marker functions always refer to the currently selected channel. To make this clear, the marker are drawn with the channels 
pen color. 
  
Working with several plotters 
  
With RealView you can use several plotters simultaneously. Plotters are arranged on pages with at least one plotter on it. 
  

 
Example with 3 plotters on a single page 
  
When RealView is started, one plotter appears on page 1. 
Now there are two ways to add a new plotter. The first is, to add new page with a plotter to the project. The second is to split the page, 
so that another plotter appears on the page. These functions can be found in the Page menu.  
  
If you select Split vertical or Split horizontal you can split the page. Move the mouse over the page and you can see the splitting line 
following the mouse. Just click to confirm the split-position and a new plotter appears on the page.  
  
With more than one plotter on a page, you can move the mouse cursor to the borderline between two plotters and move the border to 
another position, to change a plotters size. The cursor will appear as a double arrow during this operation.  
  
Use the close (X) button in the plotter caption, to close plotters that are no longer needed. Remember that at least one plotter has to be 
on a page.  
  
To create a new plotter on a new page, click the New page item from the Page menu. Enter a page name to the dialog. The new page 
will appear in the page register on bottom of the main window. Click one of the page registers entries to make a certain page visible. 
  

 
  
Printing 
  
Select the Print... item from the File menu or press the corresponding button in the toolbar to open the following preview dialog. 
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The preview window shows the diagram of the currently selected plot. You can move the diagram to any position on the paper, where 
you want it to be printed.  
The red broken line indicates the non-printing area of the selected printer.  
  
Changes of the following print parameters can be seen immediately in the preview. 
  
Scaling 
Move the scaling bar to increase or decrease the size of the printout. 
  
  
Colors 
  

l No background 
All backgrounds will be fade out. This may give better contrast for the printout. 

l S/W 
This option can be checked, when printing on black/white printers, where colored backgrounds etc. may cause trouble. There will 
be an index for each curve, so you won't get confused because the loss of colors.  

  
  
Options 
  

l Project data 
If you select this option, the project data will be printed out at the top of the paper. 

l Title 
Activate this checkbox to have the diagrams title printed. 

l Legend 
Check this option to print a legend that corresponds to the curves. 
 
Colors 
Only the curve colors are used for the legend.  
 
Pen width  
Color and pen width of a curve appear in the legend 

l Comment 
Check this option to print a comment on the diagram. To enter the comment, click on the "..." button.  

  
  
Orientation 
Switches the paper orientation between landscape and portrait format. 
  
Setup  
Click on this button to select another printer or to open the configuration dialog of your individual printer driver. The selected printer is 
displayed in the caption of the preview.  
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Print  
Starts the print process immediately.  
  
Endless form 
With this function, you can print your plot over several pages. 
(See Endless form) 
  
Close  
Closes the preview and returns to the main application. 
Endless form 
  
With this function, you can print your plot over several pages. 
All you have to do is do define the time-range per page and the start/end of the desired printout. 
The function Endless form is available in the print preview 
  

 
  
Overview 
In the top of the overview-section you can see the complete measuring duration. 
The yellow rectangle shows the current selected printing-range. Below this you can see the number of pages, which are necessary for the 
current printout. The overview responds on every change of the parameters,  so it is always actual. 
  
Start 
Here you can define the start of the printout. 

l Measurement start 
If you select this option, the printout starts with your first recorded value.  

l User defined 
With this option you can move the start of the printout to a later date.  

  
End 
Here you can define the end of the printout. 

l Measurement end 
If you select this option, the printout ends with your last recorded value.  

l User defined 
With this option you can move the end of the printout to an earlier date. 

Data export 
  
RealView exports measured data for use with other applications like MS-Excel etc. A text file is written, which can be imported and 
processed by other applications.  
  
Select the Export... item from the File menu or click the corresponding button in the toolbar. Export data is taken from the currently 
selected plotter. Only visible channels (curves) of a plotter will be exported.   
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The export dialog offers several format options. The preview shows the first three rows of exported data, as they will appear in the 
written text file. 
  
  
Export time information 
Check this option to add time information to the export file. 
  

l Absolute hh:mm:ss 
Time information for each value is exported in the format hh:mm:ss. Values measured within one second will have the same time 
information.  

  

l Relative 
Time information is exported as an offset. Time refers to the first value in the export file. Recommended for measurements with 
high sample rates.  

  
  
Export date information  
Check this option to export date information. This makes sense for recordings that were made for more than one day. 
  
Export units  
Check this option to export units with the measured values. 
  

l To each data set 
Units appear in each data set right behind the value.  

  

l To the header 
Units are exported as header in the first line of the export file.  

  
  
Field separator  
You may use either semicolons or tabulators as field separators. 
These are the usual characters for field separation. 
The TEMP directory 
  
Measurements with high sample rates produce large amounts of data. RealView stores measured data to temporary file on your hard 
disc. When RealView is terminated, these temporary files are removed from your hard disc. Usually RealView uses its own installation 
directory to store temporary files. Temporary files may remain on your hard disc, if RealView is not terminated regularly for some 
reasons. If you find temporary files in the TEMP directory of RealView, while RealView is NOT running, delete them without hesitation. 
Temporary files use the file extension ".TMP", starts with "RV_" and a large number as filename. A typical filename for a temporary file 
may be "RV_52480053.TMP". 
  
RealView stores its temporary files to the TEMP directory on your hard disc. 
The TEMP directory should always be on fast HDD drive, with high data transfer rates.  
Do not use network drives for the TEMP directory!  
  
Usually the installation will be on the local drive C:\ , so there is no need to change the TEMP directory. Otherwise select the item TEMP 
directory... from the Options menu and enter a new path on a drive that is fast enough to store the temporary files.   
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Note that RealView has to be closed and restarted, after changing the TEMP directory. As long as RealView is running, the old TEMP 
directory will remain active. 
  
Tip: 
The currently selected TEMP directory is displayed in the caption of the dialog. 
Timing 
  
Real-time sampling is quite a "hard job" for your system. The values from channels of the hardware devices have to be requested, read 
and processed continuously, and in precise intervals. This is done with a kind of an endless loop that does all the work. Quite simple so 
far, but... To keep your system running, Windows itself need some processing time for mouse control, display activities, etc. This should 
be no problem with a fast system and only one hardware device in use. But with an older PC or many hardware devices in use, you might 
get into trouble, because you are running low on processing time. Delayed mouse moves or display updates are a typical indicator for 
that. In that case it is unavoidable to make changes to the RealView timing. 
  
You can change the timing of RealView in the Options menu. 
Three options are available, to change the timing:  
  
Timing for fast systems  
Prefer this setting whenever possible. Only change the setting if mouse moves or display updates seem to be delayed.  
  
Timing for normal systems  
A setting with more processing time for the Windows system.  
  
Timing for slow systems  
Most of available processing time is used for the Windows system. 
  
Adjusting the sample rate 
  
At first sight it seems quite simple to adjust the sample rate. So what is this chapter about? 
  
Well, sample rate is adjustable from 5 ms to 30 s, but the fastest is not always the best. To find the best setting for the sample rate, the 
following three parameters should be considered:  
  
1.) The hardware devices  
There is absolutely no need, to set the sample rate faster than a device can deliver values.  
For example: The SERAI 1-8 module can deliver 200 samples/second (5ms) without problem, while a handheld multimeter will hardly 
deliver more than 2 samples/second. This means that a sample rate setting of 5 ms makes no sense for a multimeter. All you can earn is 
100 times the same value, which is absolutely redundant and excessive memory consumption may cause problems with long time 
recordings.  
  
2.) The system setup  
Maximal sample rates mentioned in the manufactures data sheets often refer to the built in A/D-converter chip. Keep in mind that 
samples still have to be requested and have to be transferred to your system. This may take quite a long time in some cases, depending 
on the technique used for communication. Most multi-channel devices multiplex the inputs to a single A/D-converter. This means that the 
sample rate of the converter must at least be divided by the number of channels to get an idea of the sample rate that is really available 
for a channel. You can try to find out the sample rate empirical. Zoom a curve that was recorded with a fast sample rate. Constant values 
for more than one sampling interval do indicate unwanted over-sampling.  
  
3.) The duration of the recording  
Think about the memory consumption of your settings. Measuring two channels with a sample rate of 5 ms needs about 3200 
bytes/second. (Each value needs 8 bytes.) Running for 1 hour with this setup would result in file with a size of 11 MB. Please think about, 
especially for long time recordings! 
The error indicator 
  
Each plotter is equipped with an error indicator. A red LED in the caption of a plotter indicates that a hardware device did not deliver a 
requested value within the sampling interval. If the LED flashes quite often or even stays on continuously, a valid measurement is 
impossible. In that case you have to reduce the sample rate. 
  
If the LED flashes now and then, it will not have much effect on the measurement. 
The NF generator for demonstration 
  
RealView is equipped with a NF generator, which is a virtual hardware device. It is integrated for demonstration and gives you the 
opportunity to get started with the software, without connecting any hardware converter to your system. 
  
If you want to use the NF generator, you have to define this, just like a "real" hardware device (see also Hardware configuration). 
  
After you have defined the NF generator as a used hardware, you will get this little panel on your screen: 
  

 
  
Here you can adjust the amplitude and the frequency of the NF generator. You can move this panel by clicking (but not on the sliding 
controller) and drawing. 
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In the example Step by Step we will explain the use of the NF generator in detail. 
Step by Step 
  
The following chapter describes a simple example and uses the NF generator, which is available for all users.  
  
First step is to start or restart the software and select New from the File menu. 
  
  
Hardware configuration 
  
First we have to define the hardware devices that are used with the new project.  
Select Hardware configuration... from the Hardware menu.  
  

 
  
This is the Hardware configuration dialog. 
Our project uses the NF generator. It can be found in the Miscellaneous section of the supported hardware list. Drag and drop the NF 
generator to the list of existing hardware devices on the right. The NF generator is now activated for your project, and the NF generator 
panel appears. 
  

 
  
This panel can not be closed, except the NF generator is removed from the hardware configuration. The NF generator offers sliding 
controls for frequency and amplitude.  
  
Close the hardware dialog with OK. The NF generator is now available for your project.  
  
Note:  
For other "real" hardware devices a configuration dialog will open, when the device is dragged and dropped to the list of existing 
hardware. In that case enter the configuration of your hardware device to the dialog. Changes to the configuration can be made, pressing 
the Setup button in the hardware configuration dialog.  
  
  
  
Channel configuration 
  
One channel is already available on the channel list left of the plotter and can now be configured. 
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The channel still don't know, where to get his measurement values. Click to the blue button of the plotter channel, to open the 
configuration dialog of this channel. 
  

 
  
For the moment we only want to assign a hardware channel to the plotter channel. Click on the Assign... button in the Source section of 
the dialog. 
  

 
  
A list of all configured hardware devices opens. Remember that our example only uses the sine generator. The (+) button of the sine 
generator opens a list with all channels of the hardware device. The sine generator offers only one output channel, called "Sine output"
Other hardware device can offer more than one channel. Select this output and close the dialog with OK to return to the channel 
configuration of the plotter. 
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The Source display shows now the hardware device and its channel, which delivers values for the plotter channel. Click on the OK 
button to confirm the setting. 
  
  
  
Adjusting the sample rate 
  
Before we start the plotter, we have to adjust the desired sample rate.The current sample rate is displayed in red above the channel list 
and shows 500 ms. Because the sine generator can produce frequencies up to 20 Hz, and we want to have a good resolution we set the 
sample rate to the fastest value 5 ms. Please note that not every hardware device can use such fast sample rates (see also Adjusting the 
sample rate). 
Click on the sample rate and select the new sample rate from the menu. 
  
  
  
Start the recording 
  
The plotter is now prepared for the first plot.  

Press  to start the plotter. The plotter writes a sine curve that is delivered from the sine generator. Changes the frequency or 
amplitude take effect on the diagram immediately.  
  
Take a look at the plot information in the caption of the plotter, where start time, stop time, memory consumption and number of 
samples are displayed.  
  

 
  
  
  
Pause mode 
  

Click on the pause button . The plotter seems to stop, but a look at the plot information shows that recording still continuous! Use the 
pause mode to analyse recorded data, without interrupting the measurement. Click on the pause button again, to terminate the pause 
mode. 
  
  
  
Changing the X-range (timerange) 
  

Click on the buttons X-Plus  and X-Minus  in the toolbar, to see the effect of these zoom buttons. The curve will be streched in 
the timerange. 
  
  
  
Changing the Y-range 
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Click on the buttons Y-Plus  and Y-Minus  in the toolbar, to see the effect of these buttons. The curve will be stretched in Y-
range 
  
Move the mouse cursor to the y scale on the left of the plot. The mouse cursor will appear as a vertical arrow.  
  

l Hold the left mouse button down and move the mouse upwards and downwards. The curve will follow your movements. Release 
the mouse button when finished. 

l Hold the right mouse button down and move the mouse upwards and downwards. The curve will be stretched according to your 
movements. Release the mouse button when finished.  

  
A simple way for Y-range adjustment!  
  
  
  
Terminating the recording 
  

Click on the stop button  in the toolbar to terminate the recording. If you restart the plotter later, the previous recording will be 
deleted. RealView will ask you then to save your recording. 
  
  
  
Marker 
  

After you finished your recording, you can use marker for further analyses. Click on the marker button  to activate the marker. 
Move the marker line to any position and read the values from the markers information display on bottom of the channel list.  
RealView offers special functions for the marker. Click on the arrow at the right of the marker button, and you will get additional 
features. 
  
  
  
Additional functions 
  
With this little example you can learn much about the possibilities of RealView. 
Just play with the settings of the plotter or the channel. Try to change the design of the plotter. Change the sample rate to see the effect 
in the quality of the signal, ... 
  
This will be the best way to learn all about RealView features. 
Project-Template  
  
With the project-template you can determine how a new RealView project has to be defined. You can define the design and the 
arrangement of the plotters, the channels and the list of used hardware. 
Each time you start RealView or create a new project, the default-project takes effect. 
  
Create the project-template 
To create a project-template, you just have to define RealView: 
  

l Define your hardware  
l Create new plotters and arrange them  
l Add your desired channels  
l Define the design of your plotters  

  
To save the project-template select from the File menu the entry Project-Templates and then the entry Save current project as 
new project-template... 
  
  
Delete the project template 
To delete the project-template select from the File menu the entry Project-Templates and then the entry Delete project-template...
  
  
Internal 
The project-template is saved in the file "DEFAULT.DAT" in the user data folder. 
In any case of problems with this file, you can delete it by yourself. 
AutoSave 
  
This option can be activated to save a project regularly. Consider that this feature needs additional processing time, so dropouts may 
appear if you have running measurement with high sample rates large data amounts.  
  
Select the AutoSave... item from the File menu. 
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Check the AutoSave option to activate the automatic saving. Enter an interval in which your project is being saved. The backup file will 
have the same file name as your project file, but the file extension is set to .BAK instead of .RLV. 
  
Caution: 
The AutoSave feature only works with projects that have saved before, which means that a project name must be available. The project 
name is displayed in the caption of the main window. New projects without filename should be saved under a certain name, so that the 
AutoSave function can work. 
Reset hardware 
  
In some case a hardware device may fail to respond. In that case it could be helpful to select the Reset... item from the Hardware 
menu once or for a few times. 
  
Project info 
  
You can add project data to each project. The project data will be saved together with the project. To call or edit the project data select 
Project info from the Options menu. 
  

 
  
These infos can be also used in the printout. 
  
Supported hardware devices 
  
A list of all supported hardware device is available from http://www.abacom-online.de/uk/html/hardware_uk.pdf. 
  
User Interface 
Self-made hardware devices (usually based on microcontrollers) can be connected using the so-called "User Interface" device. The 
device can be connected to a real serial port (COM), or with a virtual COM driver provided for many USB devices. General COM 
parameters like baudrate, start bits, stop bits and parity can be configured. Hardware handshaking is not used. 
  
Data is transfered with a readable ASCII protocol, which can be easily realized with microcontrollers. For example the transfer of three 
measuring channels could look like this: 
  
Program command line: 
Print #1, CH1;"\";CH2;"\";CH3  
  
Data output:  
123\-1.234\1.23E-3 
124\-1.235\1.24E-3 
... 
  
Above example shows the simple protocol structure: 
  

l Numeric channel values are transfered as readable ASCII text.  
l A "\" (backslash) character serparates multiple channels from each other.  
l Typically the transfer ends up with chr(13) chr(10). 

The protocol accepts chr(13) only and chr(10) only as line end indicator as well. Point and comma can both be used as decimal 
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separator. Leading characters and units in the channel data like  "I =-1,234 mA" can be used but are ignored. A value of -1,234 is 
delivered in that case. Leading characters must not contain numeric data. For example "Channel12 = 13.1 Volt" would deliver a value of 
12 instead of 13.1 ! 
  
The number of expected channels can be configured. If more or less channels than the number of expected channels are transfered, 
missing channels will be set to zero, while additional channels are ignored. The protocol works without any request, which means that 
data can be transfered at any time with a simple PRINT command. 
  
No need to say that transfer rate is physically limited by the baud rate that is used. The serial interface could be overrun if to many 
PRINT commands are sent at one time. The data tranfer can easily be verified using a terminal program. 

Seite 23 von 23Welcome to RealView 3.0

12.10.2011file://C:\Dokumente und Einstellungen\Lot\Lokale Einstellungen\Temp\~hh34EF.htm


